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1. About This Guide

This guide explains the usage of PRM Outlook Add-Ins. The screenshots used are for illustration
purpose only.

2. Intended Audience

The intended audience will be System Integrators, Technical / Administrative users who will assist
in realizing the capabilities, functions, and the full benefits of the product.

Note:

v 1. Ensure the firmware version and package version number are up-to-date and
update/upgrade accordingly.

2. For more information about the latest version and compatibility, contact the BRT
Systems sales/support.

3. Document References

Document Name Document Type | Format
BRTSYS AN 037 PRM User Guide - 1. Introduction Application Note / | PDF

BRTSYS AN 038 PRM User Guide - 2. Installation and User Guide
Configuration

BRTSYS AN 039 PRM User Guide - 3. PRM Management
Console

BRTSYS AN 040 PRM User Guide - 4. PRM and PanlLHub
Supervisor Console

BRTSYS AN 042 PRM User Guide - 6. PanL PD100 Touch
Display
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4. Getting Started with Outlook Add-In

4.1 Installing Outlook Add-In

The PRM Outlook Add-In provides an alternative option for users to view and book room(s) from the
calendar aside from the PanL display or through Outlook Web Access. Users can also view room info
and include catering or equipment ordering when sending meeting requests.

Extract or unzip the PRM- Add-In package file provided and execute the .exe file. Ensure that
.net framework v4.7.2 or newer is preinstalled. The installer can be found in the DotNetFX472
folder. Click setup.

“ s T <« PRM_v3.0.0-220 » PanlLAdd-In » PRM-Addin_2.5.0-3.3.0 B 5 Search PRM-Addin_2.5.0-3.30 y=]
5 @ OneDrive - Personal MNarme - Date modified Type Size
| Application Files File folder
& Desktop DotMNetFX472 Eilefoldar
J Downloads VSTOR4D File folder
= Documents # ik PRM-Addin.vst V57O Deployment.., 20KB
P9 Pictures » 2 setup.exe b Application 884 KB

For Outlook Add-In Update: To install a new updated version if previous Outlook add-in
version is already installed, uninstall it from installed programs under Control Panel and follow
the same steps to install a new Outlook Add-In version.

If the updated Outlook Add-In version is already installed, then an appropriate message is
displayed. Click [Close].

Microsoft Office Customization Installer

The latest version of this customization is already installed. 4 E.’
b A

Name: Panl Room Manager

files///D: MWork/Projects/MRBS/11-Releases/PRM_v3.0.0-2,2.0/PanLAdd-
In/PRM-Addln_2.5.0-3.3.0/PRM-AddIn.vsto

9 Close

If the Outlook Add-In is installed for the first time, the Microsoft Office Customization Installer
window is displayed, click [Install].

From:

Microsoft Office Customization Installer

Publisher has been verified & E;’
=
Are you sure you want to install this customization? Q

Name: Panl Room Manager

file://D: MWork/Projects/MRBS/11-Releases/PRM_v3.0.0-

Fi 3
Sl 2.2.0/PanLAdd-In/PRM-Addln_2.5.0-2.3.0/PRM-Addin.vsto

Publisher: BRT Systems Pte [ td

While Office customizations can be useful, they can potentially harm your computer. if you
do not trust the source, do not install this software. More Information...

a Install Don't Install l
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3. Upon successful installation, an appropriate message indicating the same is displayed. Close the
message window and restart Microsoft Outlook for the add-in to take effect.

Microsoft Office Customization Installer

The Microsoft Office customization was successfully installed.

Name: Panl Room Manager
file:// /Dy fWork/Projects/MRES/11-Releases/PRM_v3.0.0-2.2.0/PanLAdd-

In/PRM-Addin_2.5.0-3.3.0/PRM-Addin.vsto a

4. To verify if Add-In is successfully installed, click File > Options. The Outlook Options window
is displayed. Click on Add-Ins tab and verify whether "PanL Room Manager” is displayed as part
of the Active Application Add-Ins.

From

Close

Outlook Options ? X
General B
[- +, View and manage Microsoft Office Add-ins,
Mail :
Calendar Add-in Options
Feaph Launch Add-in options dialog: Add-in Options...
Tasks
Add-ins
Search
. ]
Language Name = Location |¥ype ‘ |
PPN A N H Add o |
Accessibility
PanL Room Manager filee//{... 5.0-3.3.0/PRM-AddInvsto  COM Add-in I.
Advanced
Customize Ribbon Inactive Application Add-ins
Antivirus Add-in ChPrograrn Files\AVG\Antivirus\x@  COM Add-in
Quick Access Toolbar . . 2 x 4
Microsaft Access Qutlook Add-in C:\Program Files (x86)\Microsoft O  COM Add-in El‘

I T PR TR SRR . T S
Add-in: Panl Room Manager

Trust Center Publisher: <Mone=
Compatibility:  No compatibility information available
Location: file:///0e/Prashanth/Work/Projects/MRES/11-Releases/PRM_v3.0.0-2.2.0/
PanLAdd-In/PRM-AddIn_2.5.0-3.3.0/PRM-AddIn.vsto
Description: ~ VSTO - Panl Room Manager

Manage: | COM Add-ins ¥ |G

Cancel
Note:
% 1. The PRM tab may not appear as part of the menu after installation due to Outlook

disabling the Add-In. This issue can be resolved by removing PRM Add-Ins from
Outlook’s blacklist. In Outlook, go to File > Manage COM Add-ins. Under PanL Room
Manager, click the "Options" dropdown, select "Always enable this add-in" and
click "Apply".

2. Ensure your default internet browser is configured correctly in order to view the
PanL Room Manager, BRT Systems Pte Ltd and More Information links
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4.2 Configure Outlook Add-In

Upon installing the Add-In and restarting Outlook, the PRM Add-In functions should appear as part

of the ribbon menu.

To configure the Add-In Settings -

1. From the outlook ribbon, click PRM > New Meeting to view the PRM Add-In Meeting interface.

Send / Receive

Home

Falder View PRM

2. Go to Settings.

' p)

PanlL Room Manager | Configuration

©

Home | Logln

) About

i3 Tutorials

Help

3. The Settings interface is displayed with the PRM Server details (if available).

PanL Room Manager
Settings

PRM Server

Name | prm.grm.local | prm.prmUocal )

URL | hups://prm prm local;443

[[] ssLvaligation

PRM Online

Cahikd

Copyright @ 2019-2023 BRT Systems Pte. Ltd

| et |

‘ Verif:,'_

| Apply |

¥250-3.3.0
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4. To select a different PRM Server, click on the dropdown control.

PanL Room Manager - X%

Settings °

PRM Server

IWETH TSR prmoprmulocal | 10.77.0.145 )

prmupim local { 16770175 )
prom.prmdocal | 10.77.0,180 )
pren.prm docal { 10.77.0.65 )
prrn.prm focal | 10.77.0.145 ) Apply

uURL

If the PRM Server details are not available as part of the dropdown list, then click on [Refresh]
to discover the PRM Server in the network. Once it is discovered, select the required PRM Server
from the dropdown list.

If the PRM Server still could not be discovered, enter the PRM Server URL manually and click
[Verify] to verify the connection. Upon successful verification, an appropriate message
indicating the same is displayed.

PanL Room Manager X

o Connection verification to PRM Server success,
PRM Online

To save PRM server settings, click &pply.

Select the SSL Validation checkbox to enable validation of the server certificate by the clients.
By default, the checkbox is unchecked indicating that the validation is disabled.

5. Click [Apply] to save the changes (if any).

PanL Room Manager i
Settings °
PRM Server
Name | prm.prm.local { prm.prm.local ) v || Refresh
URL | https://prm.prm.local:443 Verify

[] 5L valigation

Apply
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4.3 Login to PRM

To login to PRM -

1. From the PRM ribbon, click Login.

aoee o
@Tutclrials

Home Settings

PanL REoom Manager: Configuration Help

2. The PanL Room Manager login interface is displayed. To switch to a different PRM Server, click
on the hyperlink or [Change] to access the settings interface. Alternatively, upon selecting a
different PRM Server (if any) and clicking [Change] will also switch back to the settings page.

PanlL Room Manager L
Log In to PanL Room Manager
0 =. Sign in with Microsoft
[ ] Keep me signed in
[
Gy'-aii '|ii|"'(0 AN ACcouUnt you afree To our Softwars License and
PRM Online Copyright & 2019-2023 BRT Systems Pte. Ltd. ¥25.0-33.0

3. Click [Sign in with Microsoft] to login with the Microsoft account. Pick an existing account.
Alternately, click Use another account to select another account.

B Microsoft

Pick an account e

user-prme3
@ user-prm63 @mrbstest1.onmicrosoft.com

Signed in

+ Use another account

Upon successful login, the Meeting Room booking interface is displayed.

8
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4.4 Booking Meeting Room

To schedule a meeting and add rooms/equipment/catering items -

1. From the PRM ribbon, click Meeting.

{2 L ©

Home |Dashboard Notifications LogOut

PanlL Room Manager Booking

Settings  User

Configuration

@ "E" About
@ Tutorials

Help

2. The Book Meeting Items interface is displayed.

PanL Room Manager

Book Meeting Items

Loweed in e Usse 1 Er

Advanced Search ::-

| Star Dz & Time End Dice & Ting
| i .- | tr | Search
Hame A:'.I: cluniry t!u lding Floor |"'_Ipx-'.‘;.- |-'-_'ld.'!-:: |
IJn-_--.---g‘-.x.-nﬂ L4 rgapore Pava Lebas 178 B Pavn Lebiar 1TE
L] MeeungRoomd Singapore Fayn Lebar 178 o Faya Lebar 1T

3. Add Meeting Room (s) / Equipment / Catering Item (s) to the meeting appointment using the

steps given below -
To add room(s),

a.

To select room(s), click on the checkbox available next to the room name.

PanL Room Manager

Book Meeting Items

| Start Date & Timse End Date & Tima

L

Loggedin a5 User 1 ﬁ

Advanced Search ()

030672023 10:30 am 08062023 1100 am i ‘ Search
|.‘\lame & (Country ]E-mlalr'-g Froaor Capacity |-".d:.|rc55 |
ﬁﬂ:—eﬁngﬁbum1 Slngepnree P.a:,ra Lebas 178 2 o F'a}-a Lebar 178...
|:| MeetingRoomZ  Singaporee Paya Lebar 178 2 o Paya Lebar 178,
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b. The meeting room information will be displayed.

Equipment Catering

Equipment Scheduls |

[ "] Bluetooth Spea

[ Projector

MeetingRoom1
Status Active
Available Date 2% May 2023 No Eqiprent iemsts)
Email MeetingRoom1@brechip.co selected

m
Capacity ]
Floor 2@Paya Lebar 178
Address Paya Lebar 178@%ngaparss
Amenities Projector, Speaker

c. The newly added room is displayed as part of the meeting appointment window.

| File Ie=ting nsert Format Text Revims Help PR "G' Teli me what you want to do

e o 08 ee i

f;'ﬂm-}rials
Home | Dashboard Motfications LogCut -M::t|ng| Sethings  User

FanL Raom Manager Backing Configuration Help

ﬂ Yol haven't 3ent thic meeting invitatian get

Fram iiEar. |8 bt ohin com
=" Ta. MestingRoami

Send | 2UDJET

— lLocation MeetingRoom1 | | Rooms.. |
Slart lime 51..|I'I 5}'3"2035 :-'l 1[':?:‘1.?.3}-1; v| |_ all ekay svent
Endtime | Sun 6@ B [11:00am v|
v Note: Ensure to resolve the group names under the “70”and “Location” fields before

\,3 sending the meeting document.

Product Page 10
Document Feedback Copyright © BRT Systems Pte Ltd




OBRTSys

BRTSYS_AN_041 PRM User Guide - 5. Outlook Add-In

Version 2.0

Document Reference No.: BRTSYS_000112 Clearance No.: BRTSYS#073

To add equipment(s),

d. Click on Equipment tab. A list of equipment (if any) is displayed. The search box can be
used to search for the desired equipment. Click on the checkbox and select the required

equipment.

MeetingRoom1 X

MeetingRoom1

Status

Available Date

Email

Capacity
Floor
Address

Amenities

Active
29 May 2023

MeetngRooml@brichip.co
m

0

2{@Paya Lebar 178
Paya Lebar 178@35ingapores

Projector, Speaker

Equipment

@I:

—

[ 7] Bluetooth Spea
E Projector

Equipment Schedule

Projector

Status

Auailable Date 06 Aug 2023

Category

Description

Catering

Active

Paya Lebar 178

Projector

e.
availability.

Click on [Equipment Schedule] to view the equipment calendar and check for the

Panl. Room Manager v X
@E'E:' Loggedin a5 User 1 L’f
[ Tosay ]l Day [ workwesx West ] Mzt | x
© @ 06August 2023
Equipment Schedule
i Sunday
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To add Catering Items,

f. Click on Catering tab. A list of catering items (if any) is displayed. The search box can be
used to search for the desired catering item. Click the checkbox and select the required
catering item. Select the required quantity.

MestingRoom1 X

Equipmeant Cataring
Mila
[ orea
MeetingRoom1
Status Active Mila
2
Avallable Date 29 May 2023 Status Artiva
il MeetingRoom brich
il g P el o Available Date 08 Aug 2023
Capacity o Category Paya Lebar 178
Floor 2@Paya Labar 178 Description Beverages
Pri S0.00
Address Pays Lebar 178@5ingaporee e
i - 1 &+
Amenities Projector, Speaker Cluantity I:
PRM Onlina Copyright © 2015-3023 BRT Systerns Pre. Lt V140310

4. Upon adding the required room(s) / equipment(s) / catering item(s) to the meeting invitation,
select the Meeting Start Time / End Time; enter the Meeting Subject / Meeting Agenda and click
[Send]. An email notification will be sent to the list of participants/attendees.

B0 Project Meeting - Meeting = - o X
Meeting  Inset  FormatText  Review Help  PRM  Q Tell me what you want to do
RO 0O 8 @O -
- - | @ Tutorials
Home | Dashboard Notifications LogOut ~ |Meeting| = Settings User
PanL Room Manager Booking Configuration Help
You haven't sent this meeting invitation yet.
PanL Room Manager M
M 12 1 I
= | |Nome o |Country [Buiding Floor [Capacity Address
frojectuiecting. MeetingRoom! _ Singapores Payalebar 178 2 o Paya Lebar 178,
MeetingRoom1 » Room:
= [] MeetingRoom2 ~ Singaporee Payo Lebar 178 2 0 Paya Lebar 178
Mon 7/8/2023 1 10:30am w| [ anaa
Mon 7/8/2023 | 1:30am v Meetiny ml X
i, ” Equipment Catering
Here Is the meeting agenda,
. Hardware Team Update Milo
. Software Team Update [ Oveo

. System Validation Team Update

1

2

3. Documentation Team Update

a

5. Sales & Marketing Team Update

Thanks & Regards
Sarah|

MeetingRoom1

Status

Active

Available Date 29 May 2023

Email MeetingRoom1@brtchip.co
m

Capacity 0

Floor 2@Paya Lebar 178

Address Paya Lebar 178@Singaporee

Amenities Projector, Speaker

Milo

Status Active

Available Date 06 Aug 2023

Category Paya Lebar 17
Description  Beverages
Price $0.00
Quantity -[1] +
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4.5 Dashboard

The PRM dashboard displays insightful statistical information on a weekly, monthly, or yearly basis
specific to the login user.

To view the dashboard,
1. From the PRM ribbon, click Dashboard.

O 8 @0 i
ﬂTIJtDrIEH

HDmE Dashboar Motifications LogOut | Meeting | Settings  User

PanL Room hManager Booking Configuration Help

2. The User Dashboard interface is displayed. This interface provides the meeting statistics -
Booking details, if any, on a daily/weekly/monthly basis and a pictorial representation of the
statistical data. It also displays the Quota Consumption (Room Quota / Equipment Quota).

v

PanL Room Manager
@ Back Logged In a5 User 1 ﬁ

User Dashboard

Booking Details O

. Successful
Cancelied
@ uncaimed Non Recurrence

& :
W Unclaimed Recurrence

Quota Consumption Daily v

Room Quota

Total Hours Used  Not Set
Hours Left Not Set
Equipment Quota

Total Hours Used  Not Set

Hours Left Not Set
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4.6 Notifications

To view the notification updates related to meeting room, equipment, and catering items,

1. From the PRM ribbon, click Notifications.

» 4 ©Q

Home [Dashboard [Motifications LogOut | Meeting | Settings User

PanlL Room Manager Booking Configuration

| ;' About
'LF"J Tutarials

L

Help

2. The list of notifications, if any, are displayed in the table.

PanL Room Manager
@Eac'-c

Notifications e

Mark all as read | Refresh

! Room Activated!
!f.ﬁwn MeetingRoom3 (MeetingRoom3 Qbrichip.com) has been set as active by the admin

~ 4

Logged in as User 1 ﬂ

18/7/2023 3:3%:43 pm

| Room Properties Modified!
Properties- Availoble Date of the room MeetingRoom3@brtchip.com has been modifed in the
FRM

18/7/2023 9:5%:43 pm
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4.7 About

To view about the PRM Outlook Add-Ins version —

1. From the PRM ribbon, click About.

)

TR @

Horne |Dashboard Motifications LogOut

PanlL Room Manager

&

Meeting

EBooking

@O

Settings  User

Canfiguration

T3 Tutarials

Help

2. The product related information such as Version Number, Privacy Policy, Software License, Open-
Source Licenses, and copyright are displayed. Click on the respective links to view the details.

B about X

2 PanL Room Manager (PRM)

Outlook Add-in for Microsoft

Version 2.6.0-3.2.0

BRT Systems Pte. Ltd.

Address : 1 Tai Seng Avenue, Tower A, #03-01, Singapore 536464
Contact : +65 6547 4827

Email : suppori@brisys.com

Website : hitps://brisys.com

Open Source Licenses

Copyright ©2019-2024 BRT Systems Pie. Lid.
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4.8 Tutorial

To quickly get started with the PRM Add-In -

1. From the PRM ribbon, click Tutorial.

Ae 0 0B oo
o : i "-@JTutcrrials
Horne |Dashboard Motifications LogOut | |Meeting|  Settings  User
PanlL Room Manager Booking Canfiguration Help

2. The Tutorial interface is displayed. Click [Next] to navigate through the tutorial steps or click
[Close] to close the tutorial.

Tutorials

Step 1

,@ Fbau

@ Turtoria
1
b,
Lo

Fife-,

Faviniies

=

FEND ) RECENE

Click the New Meeting button on the PEM ribbon to initiate a new meeting request.

HALER i gL

i A
%3 Date

.... cict 3354

TONTTRRH(] Y1k ISLAIRg SarTR S e BT
& Frstestay

Anin i

(e Bl in 10

i akdy, Nrrr e 19, 00 630 ARS IS AN L

& Wuradey
Admin

ManLIEA

ne-ep AN iR 3 BRI PRl FOUt BT

d Lol Wik

e 4 S

= Farwerd

P bugey 2 Rl 4

! moozoly] Adwi initiebed & asiwaid ssiet Sor your accoust
Dear ghenroniman o,

Adkinin baiinilieiod o i sesct reqie focvour soeoual
Please find vour new pemsvocd med pamode below,

Passirord: FWPRSgaS
Passiode: 197770

For moes mPamsanion, please comact £ vour admin ot Adm
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5. Appendix

5.1 Glossary of Terms, Acronyms & Abbreviations

Term or Acronym

PRM
SSL

URL

Definition or Meaning

The PanL Room Manager is designed to support from large to small
organizations to automatically handle meeting room booking issues such
as room booking conflicts, ghost bookings, under-utilized rooms, etc.
Secure Sockets Layer is an encryption-based Internet security protocol.

A Uniform Resource Locator, colloquially known as an address on the Web,
is a reference to a resource that specifies its location on a computer
network and a mechanism for retrieving it.

5.2 List of Figures

NA

5.3 List of Tables

NA
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